
 

 

 

 
 
 
 
 
 

FITECH LABORATORIES 
xTier™ 2.2.1 – Installation Guide 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright  Fitech Laboratories Inc. 
300 Montgomery Street • Suite 621 

San Francisco, CA  94104 
Phone 415.371.8234 • Fax 415.371.8237 

 



 

Table of Contents
Installation ....................................................................................... 2 

Directory Structure..................................................................... 3 
Windows Start Menu .................................................................. 6 
Using xTier™ in Multiple Projects................................................... 6 

Installing the xTier™ Micro-kernels...................................................... 7 
Installing JBoss 3.x/4.x Micro-kernel............................................... 7 
Uninstalling the JBoss 3.x/4.x Micro-kernel ...................................... 8 
Installing BEA WebLogic 7.x/8.x Micro-kernel................................... 8 
Uninstalling the BEA WebLogic 7.x Micro-kernel...............................11 
Installing the SunOne 8 Micro-kernel.............................................11 
Uninstalling the SunOne8 Micro-kernel...........................................12 
Installing the Oracle AS 10g Micro-kernel.......................................12 
Uninstalling the Oracle 10G AS Micro-kernel....................................13 
Installing the WebSphere 5 Micro-kernel........................................14 
Uninstalling the WebSphere 5 Micro-kernel.....................................14 

xTier™ Management Console Plug-in Installation ................................ 15 
Installing the Eclipse 2.x/3.x Plug-in..............................................15 
Uninstalling the Eclipse plug-in.....................................................16 
Installing the JBuilder 9 Plug-in....................................................16 
Uninstalling the JBuilder 9 Plug-in.................................................16 
Installing the IntelliJ 4 Plug-in......................................................16 
Uninstalling the IntelliJ 4 Plug-in ..................................................16 
Installing the NetBeans 3 Plug-in..................................................17 
Uninstalling the NetBeans 3 Plug-in...............................................17 
Installing the NetBeans 4 Plug-in..................................................17 
Uninstalling the NetBeans 4 Plug-in...............................................17 
Installing the Oracle JDeveloper 10g Plug-in ...................................17 
Uninstalling the Oracle JDeveloper 10g Plug-in ................................18 
Installing the Oracle JDeveloper 9i Plug-in ......................................18 
Uninstalling the Oracle JDeveloper 9i Plug-in...................................18 
Installing BEA Workshop 8 Plug-in ................................................18 
Uninstalling the BEA Workshop 8 Plug-in ........................................19 

Uninstalling xTier™.......................................................................... 20 
Reinstalling or Installing a New Version..........................................20 



 

 2 

Installation 
xTier™ 2.2.1 comes with installers for Windows, Solaris, UNIX and Linux. The 
rest of this document will assume installation on Windows, with special 
comments for Solaris, UNIX or Linux specific installation issues, when 
applicable. 

The xTier™ 2.2.1 installer can be downloaded for a specific operating system 
or can be obtained from the xTier™ 2.2.1 Installation CD, in which case the 
CD will contain appropriate installers for all supported operating systems. 

To install xTier™ on Windows, run xtier_windows_2_2_1.exe (from the 
Windows directory on the installation CD if an installation CD is used, or 
alternatively from the location where the xTier™ 2.2.1 distribution was 
downloaded. This will start the GUI-based installation wizard that will guide 
the user through installation process.) 

There are several notes about installation process: 

§ xTier™ 2.2.1 requires JDK 1.4.x version. You can download the 
latest JDK version from http://java.sun.com/getjava  

§ Take note of where you install xTier 2.2, this location will be 
referred to as %XTIER_ROOT% for the remainder of the 
documentation. 

After installation is successfully completed xTier™ 2.2.1 is fully installed and 
functional. Chapter 2 and Chapter 3 contain the optional steps required for 
installation of the application server micro-kernels and the IDE plug-ins for 
the xTier™ Management Console respectively. 

Chapter 
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Directory Structure 
The following is the directory structure of the xTier™ 2.2.1 installation: 

%XTIER_ROOT% 
This is the root directory. It contains the software license 
agreement.  

%XTIER_ROOT%\bin 
This directory contains binary executable for the xTier™ 
Management Console, of the Unix Shell script. 

%XTIER_ROOT%\config 

This directory contains all the XML-based configuration files 
required by xTier™ 2.2. The developer’s application specific 
configuration files should also be placed in this directory. 

%XTIER_ROOT%\config\dtd 
This directory contains the DTDs for the XML-based 
configuration files required by xTier™ 2.2. 

%XTIER_ROOT%\config\examples 
This directory contains the configuration files used with the 
xTier™ 2.2.1 Java examples. 

%XTIER_ROOT%\plugins 
This directory contains xTier™ 2.2.1 IDE plugins for the 
following Java IDEs: 

- Eclipse 2.x 

- Eclipse 3.x 

- IntelliJ 4.x 

- JBuilder 9.x 

- JDeveloper 9.x 

- NetBeans 3.x 

- NetBeans 4.x 

- WebLogic Workshop 8.x 
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%XTIER_ROOT%\docs 
This is the root directory for all of the documentation supplied 
with xTier™ 2.2. 

%XTIER_ROOT%\docs\javadoc 
This directory contains the Javadoc API documentation for the 
xTier™ 2.2.1 Java API. 

%XTIER_ROOT%\docs\whitepapers  
This directory contains whitepapers for the following xTier™ 
2.2.1 services: 

- cache 

- config 

- i18n 

- jobs 

- cluster 

- grid 

- ioc 

- marshal 

- workflow 

It also contains xTier™ 2.2.1 overview and micro-kernel 
concept whitepaper. 

%XTIER_ROOT%\docs\manuals 
This directory contains the developer’s documentation supplied 
with xTier™ 2.2: 

§ xTier™ 2.2.1 Installation Guide (This document.) 

§ xTier™ 2.2.1 Examples Guide 

§ xTier™ 2.2.1 Quick Start Guide 

%XTIER_ROOT%\examples 
This is the root directory for the Java examples. 
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%XTIER_ROOT%\lib 
This directory contains the .jars and .zip libraries files supplied 
with xTier™ 2.2. 

%XTIER_ROOT%\lib\ext 
This directory contains external library files that are required 
by xTier™ 2.2.1 (or by examples) but are not part of xTier™ 
product. 

%XTIER_ROOT%\lib\xtier 
This directory contains internal library files that are supplied 
with xTier™ 2.2.1 and are part of xTier™ product. 

%XTIER_ROOT%\lib\xtier\jboss3 
This directory contains class libraries and XML files required by 
the xTier™ 2.2.1 micro-kernel for JBoss 3.x 

%XTIER_ROOT%\lib\xtier\jboss4 
This directory contains the class libraries and XML files required 
by xTier™ 2.2.1 micro-kernel for JBoss 4.x 

%XTIER_ROOT%\lib\xtier\wls7 
This directory contains class libraries required by the xTier™ 
2.2.1 micro-kernel for BEA WebLogic 7.x 

%XTIER_ROOT%\lib\xtier\wls8 
This directory contains class libraries required by the xTier™ 
2.2.1 micro-kernel for BEA WebLogic 8.x. 

%XTIER_ROOT%\lib\xtier\sunone8 
This directory contains class libraries required by the xTier™ 
2.2.1 micro-kernel for SUN One 8 application server. 

%XTIER_ROOT%\lib\xtier\oas10g 
This directory contains class libraries required by the xTier™ 
2.2.1 micro-kernel for Oracle AS 10g application server. 

%XTIER_ROOT%\lib\xtier\ws5 
This directory contains class libraries required by the xTier™ 
2.2.1 micro-kernel for IBM WebSphere 5.x application server. 
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Windows Start Menu 
The Windows Installer creates the program group xTier 2.2.1 – Java and 
.NET Middleware Components under the Windows Start Menu. The 
start menu gives easy access to the xTier™ 2.2.1 documentation, the xTier™ 
Management Console and the Uninstaller . The following items are located in 
the start menu. 

§ xTier™ License 

§ Java API Documentation 

§ Management Console 

§ List of all whitepapers  

§ List of all manuals 

§ xTier™ 2.2.1 Java and .NET Middleware Components Uninstaller 

Using xTier™ in Multiple Projects 
The developer is free to use xTier™ in multiple projects. xTier™ is included 
into the development project as any class library would be and is deployed in 
the same way that the application that uses it is deployed. xTier™ does not 
require a separate deployment, nor is xTier™ a “server” that is reused across 
multiple instances. The developer is free to include just the services that are 
technically required in their project and is free to deploy xTier™ in a variety 
of ways. 
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Installing the xTier™ Micro-
kernels 

Installing JBoss 3.x/4.x Micro-kernel  
xTier™ comes with pre-packaged micro-kernels for JBoss 3.x/4.x. Note that 
although the micro-kernel that ships with xTier™ provides the fastest way to 
integrate xTier™ with JBoss 3.x/4x, a custom micro-kernel for JBoss 3.x/4.x 
can also be easily developed, should the developer wish to do so. Note that 
the source code for the JBoss 3.x micro-kernel ships with xTier™ and can be 
found in the %XTIER_ROOT%/examples directory. 

To install the xTier™ JBoss 3.x/4.x micro-kernel perform the following steps: 
(Note: JBOSS_HOME corresponds to the JBoss 3.x/4.x installation root.) 

J B O S S  C O N F I G U R A T I O N  

1) Create directory %JBOSS_HOME%/server/default/deploy/xtier 
2) copy %XTIER_ROOT%/lib/xtier/xtier.jar => 

     %JBOSS_HOME%/server/default/deploy/xtier 
3) copy %XTIER_ROOT%/lib/xtier/jboss{3,4}/xtier-jboss{3,4}-mk.jar =>  

     %JBOSS_HOME%/server/default/deploy/xTier 
4) copy %XTIER_ROOT%/lib/xtier/jboss{3,4}/xtier-mk-service.xml => 

     %JBOSS_HOME%/server/default/deploy/xtier 
5) Edit the xtier-mk-service.xml file that was just copied to the xTier deployment directory and modify the 

attribute “Root” to point to the same location as XTIER_ROOT.  
 As an alternative, you can also add –DXTIER_ROOT=<dir> to the run.cmd[sh] script in the 

%JBOSS_HOME%\bin directory to supply the xTier™ installation root via a Java system 
property, where <dir> should point to the same directory as XTIER_ROOT. 

 Optionally, you can also change the attribute “Log4jCategory” in the xtier-mk-service.xml file 
to change the Log4J logging category used by JBoss. 

6) The next step is to update the kernel region associated with this deployment in xtier-mk-service.xml. 
For the purposes of this installation guide, the examples that are shipped with xTier™ will be deployed as 
illustrative of the deployment process. 

Chapter 
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 Update the following line in xtier-mk-service.xml  
<attribute name="KernelRegion">examples</attribute> to reflect that the kernel region to 
start is the “examples” region. 

7) Since the examples region has been specified as the kernel region, the implementation for the classes 
specified by the examples must also be deployed. 

 Copy  %XTIER_ROOT%/lib/xtier/xtier-examples.jar => 
     %JBOSS_HOME%/server/default/deploy/xtier 

8) Restart JBoss (or use hot-redeploy). 
 

After JBoss is restarted, you can examine xTier™ services via the standard 
JBoss JMX console. Note, it is advisable to run JBoss with “-ea” JVM option 
during development. 

Uninstalling the JBoss 3.x/4.x Micro-kernel 
To uninstall the xTier™ micro-kernels for either JBoss 3.x/4.x, perform the 
following steps: 

J B O S S  C O N F I G U R A T I O N  

1) Remove the %JBOSS_HOME%\server\default\deploy\xtier directory and all its content.  
2) Restart JBoss. 

 

Installing BEA WebLogic 7.x/8.x Micro-kernel 
xTier™ comes with a pre-packaged micro-kernels for BEA WebLogic 7/8. 
Note that although the pre-packaged micro-kernel provides the fastest way 
to integrate xTier™ with BEA WebLogic 7/8, a custom micro-kernel for BEA 
WebLogic 7/8 can also be easily developed, needed to accommodate specific 
attributes of the deployment environment or application.  

To install BEA WebLogic 7/8 micro-kernel for xTier™ perform the following 
steps: (Note: WL_HOME is BEA WebLogic 7/8 installation root.) 

B E A  W E B L O G I C  7  I N S T A L L A T I O N  I N S T R U C T I O N S  

1) Create a new directory for xTier™ => %WL_HOME%\server\lib\xtier 
2) Copy %XTI ER_ROOT%\lib\xtier\xtier.jar => 

     %WL_HOME%\server\lib\xtier 
3) Copy %XTIER_ROOT%\lib\xtier\wls{7,8}x\xtier-wls{7,8}-mk.jar => 

     %WL_HOME%\server\lib\xtier 
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4) Copy %XTIER_ROOT%\lib\xtier\xtier-examples.jar => 
     %WL_HOME%\server\lib\xtier 

5) Since xTier™ requires JDK 1.4.x version, the user must download and install the JRockit JVM 1.4.x. 
(Check www.bea.com for the most current information about supported JVM and vendors). 

 JAVA_HOME variable must point to valid JDK 1.4 installation. 
6) Add the following CLASSPATH additions:  

 
set CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier-wls7-
mk.jar; 
set CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier.jar; 
set CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier-
examples. jar; 
set JAVA_OPTIONS=-ea 
 
to the %WL_HOME%\server\bin\startWLS.cmd (sh) file for WebLogic 7 (which is typically located at 
“C:\bea7\weblogic700\server\bin\startWLS.cmd”) 
Or in the case of WebLogic 8 the 
%WL_HOME%\user_projects\domains\mydomain\startWebLogic.cmd (sh) file (which is typically 
located at “C:\bea8\user_projects\domains\mydomain\startWebLogic.cmd”) 

 
Note that “-ea” JVM option is optional for xTier™, however, it is advisable to 
use it during development.  

Setup the startup and shutdown classes in WebLogic. Startup and shutdown 
WebLogic classes will be responsible for starting up and shutting down the 
xTier™ WebLogic micro-kernel. This can be done by either manual editing of 
config.xml file or via WebLogic Administration Console. To see the result of 
starting and stopping in the 
<WLS_HOME>/user_projects/domainName/serverName/serverna
me.log file. 
 
To do it manually, add the following XML definition for the target server 
(myserver in our example) in config.xml file:  

B E A  W E B L O G I C  C O N F I G . X M L  M O D I F I C A T I O N S  

<ShutdownClass  
 ClassName="com.fitechlabs.xtier.wls7.Weblogic7MicroKernelShutdown"  
 Name="xtier-shutdown" Targets="myserver"  
/>   
 
or in the case of Weblogic 8  
 
<ShutdownClass  
 ClassName="com.fitechlabs.xtier.wls8.Weblogic8MicroKernelShutdown"  
 Name="xtier-shutdown" Targets="myserver"  
/> 
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<StartupClass  
 Arguments="log.category=xtier,root=C:\xtier-2.2.1,kernel.region=examples" 
 ClassName="com.fitechlabs.xtier.wls7.Weblogic7MicroKernelStartup"  
 FailureIsFatal="true"  
 LoadBeforeAppDeployments="true"  
 Name="xtier-startup"  
 Targets="myserver"  
/> 
 
or in the case of Weblogic 8 
 
<StartupClass  
 Arguments="log.category=xtier,root=C:\xtier-2.2.1,kernel.region=examples" 
 ClassName="com.fitechlabs.xtier.wls8.Weblogic8MicroKernelStartup"  
 FailureIsFatal="true"  
 LoadBeforeAppDeployments="true"  
 Name="xtier-startup"  
 Targets="myserver"  
/> 
 
 
Note that the root=C:\xtier-2.2.1 argument must be updated to the location that xTier was installed to. 
 
Also notice that the initial kernel region to start is specified above: kernel.region=examples and as such, the 
.jar containing the implementation for the example code must be deployed as well. (See step 3 above.)  
 
 

Note, for a Linux installation LoadBeforeAppDeployments should be set 
to false. Make sure that the “root” argument (highlighted above) points to 
the same location as XTIER_ROOT. Note also that you can supply 
XTIER_ROOT  as Java system property via –DXTIER_ROOT=<dir> and 
avoid specifying the “root” argument all together in the startup service 
definition. 

To install startup and shutdown classes through WebLogic Administration 
Console, navigate to “<mydomain>/Deployments/Startup & 
Shutdown” and follow the links to create startup and shutdown classes 
(where <mydomain> represents your target domain). 

Please note that the xTier™ shutdown class will only be called in the case of 
a normal server shutdown as “Force shutdown of this server” does not call 
the xTier™ shutdown class. 

Restart the BEA WebLogic server.  
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Uninstalling the BEA WebLogic 7.x Micro-
kernel 
To uninstall the xTier™ Micro-kernel for BEA WebLogic 7.x, perform the 
following: 

U N I N S T A L L I N G  X T I E R ™  M I C R O - K E R N E L  F O R  B E A  W E B L O G I C  

1) Remove the %WL_HOME%\server\lib\xtier directory 
2) Remove the following CLASSPATH additions:  

set CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier-examples.jar;  
set  CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier_wls{7,8}x_mk.jar;  
set CLASSPATH=%CLASSPATH%;%WL_HOME%\server\lib\xtier\xtier.jar 
set JAVA_OPTIONS=-ea 
from either startWLS.cmd[sh] or setWLSEnv.cmd[sh]. 
 

Remove startup and shutdown WebLogic classes. It can be done manually 
removing corresponding sections (see p.7 for details) in config.xml 
configuration file or through WebLogic Administration Console. 

Installing the SunOne 8 Micro-kernel  
xTier provides a micro-kernel for SunOne version 8. To install the micro-
kernel for SunOne8 please using the following steps: (Note, 
${SUNONE_ROOT} is a placeholder in the following instructions that must 
be replaced with the actual installation root of the SunOne applications server 
throughout these instructions. Typically, the installation location would be: 
C:/Sun/AppServer/domains/domain1. 

S U N O N E 8  I N S T A L L A T I O N  I N S T R U C T I O N S  

1) Copy  the ${XTIER_ROOT}/lib/xtier/sunone8/xtier-sunone8-mk.jar file => 
     ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/  
 
(Remember, you must replace ${SUNONE_ROOT} with the appropriate installation root, consequently 
the installation location would look like C:/Sun/AppServer/domains/domain1/applications/lifecycle-
modules/xtier/). 
 

2) Copy ${XTIER_ROOT}/lib/xtier/sunone8/xtier-examples.jar => 
     ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/  

3) Copy ${XTIER_ROOT}/lib/xtier/sunone8/xtier.jar => 
     ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/  

4) Copy ${XTIER_ROOT}/lib/ext/jmx/jmxtools.jar => 
     ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/  
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5) Copy ${XTIER_ROOT}/lib/ext/jmx jmxri.jar => 
     ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/  

6) Change the ${SUNONE_ROOT}/config/domain.xml file. Add the following lines inside the 
<applications> tag: 

  
<lifecycle-module 
class-name="com.fitechlabs.xtier.sunone8.SunOne8MicroKernel"  

classpath="${SUNONE_ROOT}/applications/lifecycle-modules/xtier/x tier-sunone8-
mk.jar:${SUNONE_ROOT}/applications/lifecycle-modules/xtier/xtier.jar:${SUNONE_ROOT}/applications/lifecycle-
modules/xtier/xtier-examples .jar: ${SUNONE_ROOT}/applications/lifecycle-modules/xtier/jmxtools.jar: 
${SUNONE_ROOT}/applications/lifecycle-modules/xtier/jmxri.jar" enabled="true" is-failure-fatal="false" name="xtier-mk"> 

<property name="root" value="c:\xtier-2.2.1"/> <! -- Update this value to the actual installation root. --> 
<property name="kernel.region" value="examples "/> 
<property name="locale" value="en_US"/> <!-- This property is optional --> 
<property name="log.category" value=""/> <!-- This property is optional --> 

 </lifecycle-module> 
 

7) Add security permission in ${SUNONE_ROOT}/config/server.policy: 
 
grant { 

 permission javax.managem ent.MBeanServerPermission "createMBeanServer";  
 permission javax.management.MBeanPermission "*","registerMBean"; 
 permission javax.management.MBeanPermission "*","unregisterMBean";  
 permission javax.management.MBeanTrustPermission "register";  
 permission java.util.PropertyPermission "*", "read,write";  
 permission java.net.SocketPermission    "*", "accept"; 
 permission java.net.SocketPermission    "*", "resolve";  
 permission java.lang.RuntimePermission "shutdownHooks"; 
 permission java.lang.reflect.ReflectPermission "suppressAccessChecks";  

}; 
8) Start SunOne application server. 
9) You can run the HTTP administration console - http://localhost:4848/asadmin/index.html. Note that 

the port number can vary. 
10) View the server trace file at: ${SUNONE_ROOT}/logs/server.log. 
11) The JMX management console is available at http://localhost:8082. 

Uninstalling the SunOne8 Micro-kernel 

U N I N S T A L L I N G  T H E  S U N O N E 8  M I C R O - K E R N E L  

1) Remove the ${XTIER_ROOT}/lib/sunone8/xtier-sunone8-mk.jar file from 
${SUNONE_ROOT}/applications/lifecycle-modules/xtier directory. 

2) Undo the changes made to ${SUNONE_ROOT}/config/server.policy and 
${SUNONE_ROOT}/config/domain.xml files.  

3) Restart SunOne8 server. 

Installing the Oracle AS 10g Micro-kernel 

O R A C L E  A S  1 0 G  I N S T A L L A T I O N  I N S T R U C T I O N S  

1) Copy  ${XTIER_ROOT}/lib/xtier/oas10g/xtier-oas10g-mk.jar => 
     ${OAS_ROOT}/applications/xtier (where ${OAS_ROOT} often looks like "C:/oas/j2ee/home"). 

2) Copy  ${XTIER_ROOT}/lib/xtier/oas10g/xtier.jar => 
     ${OAS_ROOT}/applications/xtier 
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3) Copy  ${XTIER_ROOT}/lib/xtier/oas10g/ xtier-examples.jar => 
     ${OAS_ROOT}/applications/xtier 

4) Make the following changes in the ${OAS_ROOT}/config/server.xml file. Add the following lines inside 
the <application-server> tag: 

  
<init-library path="../applications/xtier/xtier.jar" /> 
<init-library path="../applications/xtier/xtier-oas10g-mk.jar" /> 
<init-library path="../applications/xtier/xtier-examples.jar" /> 
<startup-classes> 
  <startup-class classname="com.fitechlabs.xtier.oas10g.Oas10gMicroKernelStartup" failure-is-
fatal="false"> 
    <execution-order>0</execution-order> 
    <init-param> 
      <param-name>root</param-name> 
      <param-value>c:\xtier-2.2.1</param-value>   <!-- Update to the actual installation root. -->  
    </init-param> 
    <init-param> 
      <param-name>kernel.region</param-name> 
      <param-value>examples</param-value> 
    </init-param> 
    <init-param> 
      <param-name>log.category</param-name>   <!-- This property is optional . -->  
      <param-value>xxx.zzz.yyy</param-value> 
    </init-param> 
    <init-param> 
      <param-name>locale</param-name>   <!-- This property is optional . -->  
      <param-value>en_US</param-value> 
    </init-param> 
  </startup-class> 
</startup-classes> 
  
<shutdown-classes> 
  <shutdown-class classname="com.fitechlabs.xtier.oas10g.Oas10gMicroKernelShutdown"> 
    <execution-order>0</execution-order> 
  </shutdown-class> 
</shutdown-classes> 
 

5) Start the Oracle 10g application server. To see the start and stop messages, please view the Oracle 10g 
application server console. The HTTP administration console is available at: http://localhost:8888, while 
the JMX management console is available at http://localhost:8888/adminoc4j/oc4j. 

Uninstalling the Oracle 10G AS Micro-kernel 

U N I N S T A L L I N G  T H E  O R A C L E  1 0 G  A S  M I C R O - K E R N E L  

1) Remove the ${XTIER_ROOT}/lib/xtier/oas10g/xtier-oas10g-mk.jar file from the 
${OAS_ROOT}/applib directory. 

2) Delete the changes made to the ${OAS_ROOT}/config/server.xml file (see installation steps above).  
3) Restart the Oracle AS 10g server. 
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Installing the WebSphere 5 Micro-kernel 

I N S T A L L A T I O N  I N S T R U C T I O N S  

1) Copy  ${XTIER_ROOT}/lib/xtier/ws5/xtier-ws5-mk.jar => 
${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier  
(where ${WS5_HOME} often looks like "C:/Program Files/WebSphere/AppServer"). 

2) Copy  ${XTIER_ROOT}/lib/xtier/ws5/xtier.jar => 
${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier  

3) Copy  ${XTIER_ROOT}/lib/xtier/ws5/xtier-examples.jar => 
${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier  

4) Start the WebSphere application server.  
5) Run the HTTP administration console - http://localhost:9090/admin/. 
6) Go to Servers->Application servers->SERVER_NAME->Administration services->Extension MBean 

providers.  
7) Press New. 
8) Enter classpath='mk installation path' like '/installedApps/SERVER_NAME/APP_NAME.ear/xtier'. 
9) Enter name and description (any).  
10) Press OK.  
11) Enter created provider again.   
12) Click 'extensionMBeans' link below.  
13) Press New.  
14) Enter 'descriptor URI'=xtier-mk-mbean.xml and 'type'=xtier-ws5-mk.  
15) Press OK. 
16) Go to Servers->Application servers->SERVER_NAME->Custom services.  
17) Press New. 
18) Check 'Startup' checkbox . 
19) Enter 'classname'=com.fitechlabs.xtier.ws5.WebSphere5MicroKernel. 
20) Enter any name and description, 

classpath='${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier/xtier.jar; 
${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier/xtier-examples.jar; 
${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier/xtier-ws5-mk.jar;' (Note, that if 
installing on Linux, the classpath should be separated by “:” and not “;” which is Windows specific.) 

21) Press OK.  
22) Enter created service again.    
23) Click 'custom properties' link below and add 2 properties: root=c:\xtier-2.2.1: and kernel.region=examples 
24) In order to run the JMX HTTP console, register JMX HTTPConnector in Administration services/JMX 

connectors.      
25) Save the configuration (with the link in messages area).  
26) Stop the server and start it again – xTier should start as well.   
27) View server trace file at: \logs\SERVER_NAME\SystemOut.log 

Uninstalling the WebSphere 5 Micro-kernel 

R E M O V I N G  T H E  W E B S P H E R E  5  M I C R O - K E R N E L  

1) Remove the ${WS5_HOME}/installedApps/SERVER_NAME/APP_NAME.ear/xtier directory. 
2) Undo the changes in HTTP administration console. (See the installation steps above.) 
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xTier™ Management 
Console Plug-in Installation 

Installing the Eclipse 2.x/3.x Plug-in 
xTier™ is shipped with an Eclipse plug-in which allows the developer to 
launch the xTier™ Management Console from within Eclipse. 

Unzip 
%XTIER_ROOT %/plugins/com.fitechlabs.xnova.eclipse{2,3}plugi
n_2.2.1.zip to the %ECLIPSE_HOME%/plugins directory and then 
launch Eclipse. 

The next step is to configure the plug-in’s %XTIER_ROOT % (in the case 
of this example, C:\xTier-2.2.1) and Console locale parameters. Launch the 
Eclipse Preferences dialog by selecting the Windows >> Preferences 
menu item and you will notice a new entry for xTier™ at the bottom of the 
list. Select xTier™ from the list and then enter the installation root for the 
xTier™ installation as well as the desired locale. 

Next, configure your current the Java perspective to include xTier™ by 
selecting the Window >> Customize Perspective… menu item. (When 
installing on Eclipse 2.x select "Available Items" and then expand the "Other" 
node to find the "xTier Action Set" item.) In the available command groups 
list, scroll down and you will see “xTier Action Set”. Select “xTier Action Set” 
to add the xTier™ Action Set to the java perspective. 

You should now see an xTier™ menu item. From this menu you can launch 
the xTier™ Management Console. 
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Uninstalling the Eclipse plug-in 
To uninstall the xTier™ Management Console Eclipse 2.x/3.x plug-in simply 
delete the com.fitechlabs.xnova.eclipse3plugin_2.2.1 plug-in directory 
that was created in %ECLIPSE_HOME%/plugins when unzipping the 
installation file during installation. 

Installing the JBuilder 9 Plug-in 
xTier™ ships with a plug-in for JBuilder. To install this plug-in extract the file 
xtier.jb9plugin_2.2.1.zip located in the %XTIER_ROOT%/plugins 
directory to the %JBUILDER_HOME%/lib/ext directory. (This zip file 
contains 2 jars: gbhelper.jar and xtier-jb9-plugin.jar.) JBuilder will 
automatically load the plug-in the next time that it runs. Upon launching 
JBuilder, you will notice a new xTier Management Icon on the toolbar, as 
well as one located at Tools >> xTier Management Console.  

The final step is to configure the %XTIER_ROOT% and the Console 
locale parameters for the plug-in. You can launch the preferences page 
with: Tools >> IDE Options. 

Uninstalling the JBuilder 9 Plug-in 
To delete the JBuilder 9 plug-in, simply delete the gbhelper.jar and xtier-
jb9-plugin.jar files from the %JBUILDER_HOME%/lib/ext directory. 

Installing the IntelliJ 4 Plug-in 
Unzip ${XTIER_ROOT}/plugins/xtier.intellij4plugin_2.2.1.zip file 
into ${IDEA_HOME}/plugins directory. Next, launch the IntelliJ IDEA 
IDE. Open Settings dialog (File->Settings). An "xTier plugin" button should 
appear among the IDE Settings. Click this button to invoke xTier™ plugin 
settings. Fill in the appropriate xTier™ root path, the JRE 1.4.x path and 
locale. Close the settings window. The xTier™ Management Console can 
more be launched using Tools -> xTier Management Console or the 
corresponding toolbar button. 

Uninstalling the IntelliJ 4 Plug-in 
Remove contents of xtier.intellij4plugin_2.2.1.zip file from the 
${IDEA_HOME}/plugins directory. Restart the IntelliJ IDEA IDE. 
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Installing the NetBeans 3 Plug-in 
Unzip ${XTIER_ROOT}/plugins/xtier.netbeans3plugin_2.2.1.zip file 
into the ${NETBEANS_HOME}/modules directory. Next, launch 
NetBeans IDE. Invoke the NetBeans control panel (menu Tools -> Options). 
An "xTier" folder should appear among the IDE Settings. Fill in the 
appropriate xTier™ root path and the JRE 1.4.x path and locale. Close the 
settings window. The xTier™ Management Console can be launched from 
Tools -> xTier Management Console or the corresponding toolbar button. 

Uninstalling the NetBeans 3 Plug-in 
Remove contents of the xtier.netbeans3plugin_2.2.1.zip file from the 
${NETBEANS_HOME}/modules directory. Restart the NetBeans IDE.  

Installing the NetBeans 4 Plug-in 
Unzip ${XTIER_ROOT}/plugins/xtier.netbeans4plugin_2.2.1.zip file 
into the ${NETBEANS_HOME}/modules directory. Next, launch 
NetBeans IDE. Invoke the NetBeans control panel (menu Tools -> Options). 
An "xTier" folder should appear among the IDE Settings. Fill in the 
appropriate xTier™ root path and the JRE 1.4.x path and locale. Close the 
settings window. The xTier™ Management Console can be launched from 
Tools -> xTier Management Console or the corresponding toolbar button. 

Note: in NetBeans 4 beta release you need to “Add Module” via Tools -> 
Options -> IDE Configuration -> Modules -> Add Module after unzipping 
${XTIER_ROOT}/plugins/xtier.netbeans4plugin_2.2.1.zip file into 
the ${NETBEANS_HOME}/modules directory. 

Uninstalling the NetBeans 4 Plug-in 
Remove contents of the xtier.netbeans4plugin_2.2.1.zip file from the 
${NETBEANS_HOME}/modules directory. Restart the NetBeans IDE.  

Installing the Oracle JDeveloper 10g Plug-in 
Unzip the ${XTIER_ROOT}/plugins/xtier.jdev10gplugin_2.2.1.zip 
file into the ${JDEV_HOME}/jdev/lib/ext directory and launch the 
JDeveloper IDE. Invoke the JDeveloper 10g control panel (Tools -> 
Preferences). An "xTier" folder should appear among the IDE Settings. Fill in 
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the appropriate xTier™ root path and the JRE 1.4.x path and locale. Close 
the control panel window. 

The xTier™ Management Console can be launched by Tools -> xTier 
Management Console or the corresponding toolbar button. 

Uninstalling the Oracle JDeveloper 10g Plug-in 
Remove contents of the xtier.jdev10gplugin_2.2.1.zip file from the 
${JDEV_HOME}/jdev/lib/ext directory. Restart the JDeveloper IDE. 

Installing the Oracle JDeveloper 9i Plug-in 
Unzip the ${XTIER_ROOT}/plugins/xtier.jdev9iplugin_2.2.1.zip file 
into the ${JDEV_HOME}/jdev/lib/ext directory and launch the 
JDeveloper IDE. Next, invoke the JDeveloper 9i control panel (Tools -> 
Preferences). An "xTier" folder should appear among the IDE Settings. 

Fill in the appropriate xTier™ root path and JRE 1.4.x path and locale. Close 
the control panel window. 

The xTier™ Management Console can be launched by Tools -> xTier 
Management Console or the corresponding toolbar button. 

Uninstalling the Oracle JDeveloper 9i Plug-in 
Remove contents of the xtier.jdev9iplugin_2.2.1.zip file from the 
${JDEV_HOME}/jdev/lib/ext directory. Restart the JDeveloper IDE. 

Installing BEA Workshop 8 Plug-in 
Unzip the xtier.wlw8plugin_2.2.1.zip archive to the 
%BEA_HOME%/%WEBLOGIC8%/workshop/extensions directory 
and launch WebLogic Workshop 8. Next, invoke the Workshop IDE 
Properties (Tools -> IDE Properties...) where the xTier™ folder should 
appear among the list of IDE Properties. Fill in the appropriate xTier™ root 
path, the JRE 1.4.x path and the locale. Now, close the properties window.  

To launch the xTier™ Management console, use the menu item (Tools -> 
xTier™ Management Console) or the corresponding toolbar button. 
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Uninstalling the BEA Workshop 8 Plug-in 
Remove the previously installed files from the 
%BEA_HOME%/%WEBLOGIC8%/workshop/extensions directory. 
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Uninstalling xTier™  
To uninstall xTier™ on Windows, from the Windows Start Menu navigate to 
and click xTier – Java and .NET Components Uninstaller. This will start 
the GUI-based uninstaller that will launch the uninstall wizard.  

Note that the uninstallation wizard will not uninstall the pre-packaged micro-
kernels for JBoss 3.x and BEA WebLogic 7.x that could have been optionally 
installed by the end user after the xTier™ installation wizard completed. 
(Consult the sections of this document which specifically deal with JBoss and 
WebLogic installation for proper uninstallation instructions for the pre-
packaged xTier™ micro-kernels.) 

The uninstallation wizard will not uninstall the IDE plug-ins that the user may 
have installed in their respective IDEs. See the uninstallation instructions in 
the plug-in section. 

Reinstalling or Installing a New Version 
Before installing a new version of xTier™ (i.e. moving from xTier™ 2.0 to 
xTier™ 2.2) or reinstalling the current version, the user needs to uninstall the 
currently installed xTier™ software.  

Note also that all the files under %XTIER_ROOT% will be deleted when 
uninstalling xTier™. If there are any files that have to be preserved, the files 
must be copied elsewhere before the uninstalling begins.  
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